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Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG (“Siemens”). They are non-
binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 
Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 
By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  
The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with industrial security functions that support the secure 
operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 
Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  
For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity. 

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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1 Introduction 

1.1 Target Group  

This documentation is aimed at persons involved in the areas of operator control. 

1.2 Intended Audience 

This documentation provides detailed instructions for operators who need to control 
and monitor processes using the software product BRAUMAT / SISTAR. 

1.3 BRAUMAT / SISTAR Software Structure 

The BRAUMAT / SISTAR software consists of the following modules: 

• The configuration system: 

– Visualization System 

– Automation System 

– Recipe System 

– Route control 

• The runtime system: 

– Visualization 

– Order Management 

– Messages 

– Curves  

– Step protocols 

1.4 Abbreviations used 

Throughout this document, the following abbreviations are frequently used: 

 

Table 1-1 

Abbreviation Complete name Description 

ICM Individual Control 
Module 

Valves, pumps and motors 

BLR Binary Logic Result Configuration and online representation of 
connection logics 

OP-REQ Operator Requests Requests which need interaction and must 
be confirmed by the operator  

ROP Recipe Operation A block/step in the recipe on the recipe 
server 

EOP Equipment Operation An assigned function on the automation 
system representing the recipe operation 

RCS Route Control 
System 

Route control 

PCU  Process Control Unit Responsible for the coupling between AS 
and OS or OS and OS 

IOS Information- and 
Operation System 

Server or Client Station 
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2 BRAUMAT / SISTAR Application Center 
The Application Center is used for the overview and selection of all selectable 
applications of the system. For the Plant Operations the tabs Production and 
Archives are used. The Application Center can be started from the desktop by 
clicking on the following button: 

     

 

Table 2-1 

Application 
(Production) 

Symbol Function 

Process 
diagrams 

 

Used as Runtime System to visualize, operate 
and control the entire production plant.  

Sequence 
control 

 

Used for the representation of the current state of 
the process cells. In addition, it is possible to 
select and to operate the individual units. With 
this, the user can intervene in the current process 
and influence the different processes. 

Order 
management 

 

Used to create, process, track and monitor orders 
and batches. 

RCS online 

 

Used for planning, processing and the diagnosis 
of routes. It allows controlling and monitoring in 
an easy and transparent manner. 

Recipe 
management 

 

Used for the generation and administration of the 
recipes, e.g. changing parameter values. 

Recipe online 

 

Used to visualize the processing steps of the 
control recipes. Based on the recipe procedures, 
the recipe system generates the control recipes 
by substituting the process/order parameters with 
the current master recipe/order parameters. 

Batch trends 

 

Used for a graphic output of measured values. It 
enables the time display of archived or running 
curve values as diagrams on the screen. 
Measurement value curves can be loaded from 
different area servers via an area selection 
dialog.  
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Application 
(Production) 

Symbol Function 

Step protocols 

 

Used to view and print Step log files. 

Changes and 
messages 

 

Used to display and print messages as well as 
any recorded process operations and 
configuration changes from the same time period. 

Maintenance 

 

The application maintenance data is used for 
default, checking and acknowledging 
maintenance intervals, e.g.  
Maintenance data for ICMs 
Maintenance data for user aggregates 

Special Values 

 

The application “Special values” is used to define 
and edit of up to 511 special values.  

 

2.1 Language Selection 

In the delivery version of the system the languages, 'German', 'English', 'Spanish' 
and 'Chinese' are available. Upon request, other languages can also be created 
and supplied. 

To change the language, navigate to the “Menu > Functions > Language”. 

A new dialog opens where the new language can be selected and applied with the 
“OK” button. 

After a new language was selected the BRAUMAT / SISTAR system application 
need to be restarted. 

 

Figure 2-1 
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3 Process Mode - User Interface 

3.1 Introduction 

This chapter gives you an overview over the basic handling of BRAUMAT / 
SISTAR and introduces you to the most important functionalities how to control and 
observe the running process. 

3.2 Basic Tasks of the User Interface 

In principle, the OS user interface provides the following tasks in process mode: 

• Continuous overview of the entire plant and the corresponding units 

• Focusing the plant operator's attention to possible problems 

• Quick change of pictures and explicit selection of the process pictures, e.g. in 
which errors have occurred. 

• Fast operator control sequences using operator buttons at standardized 
positions. 

• Actual status of the current Batches  

3.3 Typical Layout of the User Interface 

In general, the BRAUMAT / SISTAR user interface is configurable and could 
therefore vary in different projects. The Screenshot below is showing a typical user 
interface where all the necessary information’s are available to control the process 
easily. The different sections of the example are described in the next chapters. 

 

Figure 3-1 
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3.4 Overview Area 

The upper part of the screen is divided into 2 area panels: 

• The top part is showing the “Message control faceplate” which informs the 
operator about all relevant Alarms and Messages. 

• The bottom part is showing the “Smart unit faceplates”. Each faceplate is 
representing one Unit.   

Error messages, warnings, process messages and operation messages are 
displayed as icons and can be reset and acknowledged.  

You can jump directly to process picture of the Unit by clicking on it.  

 

Figure 3-2 

 

 

3.5 Work Area 

The so called “Work Area” is the center part of the process image and visualizes 
the actual process information for the related units, equipment’s and control 
modules.  Additionally, it gives the operator the possibility to interact with the 
process. 

 

Figure 3-3 
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3.6 Button Area 

The button area allows the operator to access several other Applications, e.g. the 
Archive System or Step protocol directly from the process picture. 

 

Figure 3-4 

 

3.7 Appearance of the Cursor during Operation 

The operator can interact with the process by moving the mouse cursor to an 
object, e.g. button, button or faceplate. If the object is operate-able the normal 
cursor turns into a “Hand” cursor. By left clicking on the object the configured 
actions will be carried out, e.g. open a Valve faceplate. 

 

Figure 3-5 

 

 

By right clicking on an object a further dialog named “Operations and Messages” 
appears which will guide you directly to application “Message Archive”. See 
chapter 8.2  Message archive for more details. 

 

Figure 3-6 

 

3.8 ToolTip Function 

A Tooltip is a message which appears when a cursor is positioned over an object, 
e.g. a Block icon. In BRAUMAT / SISTAR context the Tooltip is showing the PCU 
number and the instance name. 

 

Figure 3-7 

 

 

The tooltip functionality can be enabled / disabled from the Process Diagrams 
“Menu bar > Options > Tooltips”. 

 



3 Process Mode - User Interface 

 

BRAUMAT Manual 
Entry-ID: 80142364,    V 2,    07/2019   11 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Figure 3-8 

 

3.9 Common Functions  

BRAUMAT / SISTAR consists of several applications. In this section, functions 
which are common to all of them are described. If needed, the common functions 
can be displayed or hide from the “Menu bar > Options > Toolbar”. 

 

Exit the program 

To exit the current program:  

• Click the corresponding icon (see image), 

 

Figure 3-9 

 

or 

• Press “Alt” + “F4”, 

or 

• From the Menu, navigate to “Program” and select the entry “End” 

ICM (Valve, Motor) - acknowledge fault 

To acknowledge all pending ICM alarms: 

• Click the corresponding icon (see image),  

 

Figure 3-10 

 

or 

• Press “F11”, 

or 

• Select the entry menu item “Acknowledge > Acknowledge ICM errors” 
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Acknowledge horn 

To reset the alarm device (lamp, horn): 

• Click the corresponding icon (see image),  

 

Figure 3-11 

 

or 

• Press “F12”,  

or 

• Select the menu item “Acknowledge > Acknowledge horn” 

Log Off 

To Log Off from the BRAUMAT / SISTAR System:  

• Click the corresponding icon (see image),  

 

Figure 3-12 

 

or 

• Select the menu item “Functions > Reset Password” 

The current user will be logged out, and logged files are not registered under this 
user anymore. 

3.10 Symbolic Icons in the Process Picture 

Next to the individual devices, one or more additional icons may be displayed in the 
process picture, indicating the device status. 

 

Table 3-1 

Priority Icon Meaning 

1.  
 

Affected by Maintenance (ABM) 

2.  
 

In maintenance 

3.  
 

Manual operation active 

4.  
 

„Force release“ active 

5.  
 

„Simulation feedback“ active 

6.  
 

Interlock is active, Device could not be switched on or operated 
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Example for a device status: “Manual operation active, ‘Force release’ active”: 

 

Figure 3-13 

 

3.11 Working with Tags and Variables 

Tags are names given to various project components, like valves, motors and 
controllers. A tag uniquely identifies the corresponding object. 

3.11.1 Searching for Variables and Objects in Project Pictures 

With BRAUMAT / SISTAR it is possible to search for objects used in the project by 
means of their tags. Searches can be performed in scope off the current picture 
(local tag search) or in scope off all pictures (global tag search). 

Searching within a picture 

To start a local tag search, do one of the following: 

• Click the highlighted icon,  

 

Figure 3-14 

 

or  

• Click the menu item “Process diagrams > Tag search > Within picture” 

 

A dialog box opens which lists all tags in the current picture, sorted by their name. 
You can use the dropdown list “Filter” to limit the displayed tags to specific types. 

Selecting one of entries in the main list will highlight the corresponding component 
in the process picture. 
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Figure 3-15 

 

Global Tag search 

To start a global tag search: 

• Click the highlighted icon,  

 

Figure 3-16 

 

or  

• Click the menu item “Process diagrams > Tag search > Global” 

 

A dialogue with two tabs “Seek” and “Browser” will open. 

Select the “Seek” tab to search for a specific string across the project. 

1. By entering the tag name in the “Seek” field and clicking on the “Start” 
button (1), the “Result” section will show matches to the search term. 

2. Additional filter options will help you to limit the result set. 

3. Click the button “Goto process diagram” (2) to automatically jump to the 
Process Diagram in which the tag was found and highlight the object. 
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Figure 3-17 

1

2

 

 

Alternatively, select the “Browser“ tab to browse through the whole project. 

The dropdown list “PCU” (1) and the “Class” list (2) allow you to filter the tags in the 
project. 

The Instances list (3) will be immediately updated with the tags which match the 
filter criteria. 

 

Figure 3-18 

1

2 3

4

 

 

Click the button “Goto process diagram” (4) to automatically jump to the Process 
Diagram in which the tag was found and highlight the object. 

 

Click “Goto process image” and the image of the corresponding tag will open. 
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3.11.2 Tag Information 

To display the information associated with tags in the current picture: 

• Click the highlighted icon, 

 

Figure 3-19 

 

Or 

• Click the menu item “Process diagrams > Tag information” 

 

As a result, the tags of all components are superimposed on the current picture: 

 

Figure 3-20 

 

 

3.11.3 Setting Bit Variables (for Switches and Selections) 

Depending on the configuration of the project there are two ways to set/reset a bit 
variable  

• Directly by clicking onto the Button in the process picture, 

Or 

• Indirectly, by clicking onto the Button in the process picture a further dialog box 
opens where the operator can set or reset the corresponding bit variable, see 
below: 

 

You can either set or clear the corresponding bit flag. Confirm your selection by 
clicking the “OK” button 

 



3 Process Mode - User Interface 

 

BRAUMAT Manual 
Entry-ID: 80142364,    V 2,    07/2019   17 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Figure 3-21 

 

3.11.4 Setting Text Variables 

Double-clicking on a text variable opens a dialog box.  

The “Selection” dialog shows a list of predefined texts for the corresponding 
variable. 

Chose the desired value with a single mouse click and confirm your selection by 
clicking the “OK” button. 

 

Figure 3-22 

 

3.12 Binary Connection Logic (BLR) 

The "Binary Connection Logic" application provides a graphically representation of 
connection logics to the operator for fast and easy diagnostics and troubleshooting 
of a logic operation status (inputs, interim results/gate and output) which are 
typically used for Interlock purposes. 

If the input value(s) or the output value of the logical operating results to “FALSE” 
the element is displayed in red color, otherwise in green color. 

Figure below is showing an example of the BLR object where the logical operation 
results to “FALSE”. 
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Figure 3-23 

 

 

Figure below is showing an example of the BLR object where the logical operation 
results to “TRUE”. 

 

Figure 3-24 

 

 

Depending on the context of use, it could be opened by one of the following 
applications: 
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• From the ICM faceplate by pressing the button “Status” in the release section  

 

Figure 3-25 

 

• From the Unit faceplate by using the command “Permanent condition”   

(Sequence Interlock) 

 

Figure 3-26 

 

• From the Unit faceplate by using the command  “Next Step condition“ 

(Step Interlock) 

 

Figure 3-27 

 



4 Faceplates 

 

BRAUMAT Manual 
Entry-ID: 80142364,    V 2,    07/2019   20 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4 Faceplates 

4.1 Introduction 

Faceplates are pop-up windows that appear when the user left-clicks on an object 
on the image such as a valve or pump. The resulting pop-up window can be used 
to issue commands to the device or to switch between automatic and manual 
mode. 

4.2 Individual Control Elements (ICM) Faceplate  

For the monitoring, control and simulation of Individual Control Elements (valves 
and motors) a faceplate is available. The faceplate is displayed by double-clicking 
the corresponding element symbol. 

The faceplate dialog provides five tabs: 

• General 

• Seat lifting (optional) 

• Extended 

• Maintenance 

• Parameter 

• Batch 

• About 

Tab “General” 

The tab “General” gives an overview over the current state of the ICM and allows 
the basic control of it. 

 

Figure 4-1 
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Status Overview Section 

In the left part of the faceplate, the status overview of the ICM is displayed by the 
meaning of six status bits.  

 

Figure 4-2 

 

Their respective meanings are: 

 

Table 4-1 

Abbrev. Meaning Value = 1 Value = 0 

CA Command automatic, Control 
of the user program or 
procedure 

activate deactivate 

ILK Operating Interlock Enabled, ICM can 
be switched on. 

Locked, ICM is 
automatically turned off 
and locked. 

ON Feedback ON of ICM On  

OFF Feedback OFF of ICM Off  

MAN Manual mode Mode is Manual Mode is Automatic 

LO Load output Active Inactivate 

 

Additionally, the displayed symbol of the ICM is indicating whether the ICM is 
switched on or off or if a possible error is active. The table below is illustrating the 
symbols and their meaning. 

 

NOTE Depending on the project configuration the representation of the symbols and 
their meaning could vary.  
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Table 4-2 

Symbol State 

 

Off 

 

Command Off 

 

Command On 

 

On 

 

Error Off 

 

Error Command Off 

 

Error Command On 

 

Error ON 

Release Section 

The interlock status of the ICM is shown in the release section.  

Possible values are “released” or “locked”. By clicking on the status button a 
separate window opens which displays the binary logic that caused the interlock. 



4 Faceplates 

 

BRAUMAT Manual 
Entry-ID: 80142364,    V 2,    07/2019   23 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Figure 4-3 

 

Control Section  

In the control section the operator mode can be switched between automatic and 
manual mode via the corresponding buttons. The actual operation mode and state 
of the ICM is displayed. The ICM can be switched to “On” or “Off” by using the 
corresponding buttons. If active, the current fault of the ICM (for example no 
feedback or expired timeouts) could be acknowledged by clicking the button "Q". 

 

Figure 4-4 

 

 

NOTE Depending on the configuration, it may be that Handgroups are used in the 
project. Handgroups have an influence of the behavior when switching between 
automatic and manual mode. In this case, a combination of objects can be 
switched simultaneously. This can affect the current process. 

 

Unit Section 

In the unit section the configured units are displayed. Each ICM can be assigned to 
up to two units. The unit which has requested a route is displayed in the second 
field when the ICM is occupied by a Route Control Server. When no unit 
assignment has been configured, the RCS unit is displayed in the left field. 

 

Figure 4-5 
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Error Counter Section 

The number of monitoring time violations is displayed in the error counter section. 
The counter can be reset by pressing the "Reset" button. 

 

Figure 4-6 

 

Monitoring Time Section 

A monitoring time is the maximum time that can be used to complete an action, 
e.g. until a valve reaches its end position. After that time a fault for the ICM will be 
generated. The monitoring time section is providing the number of seconds till the 
monitoring time expires.  

 

Figure 4-7 

 

Tab “Batch” 

The “Batch” tab is providing detailed information about the batch running on the 
sequence to which this ICM is assigned. 

 

Figure 4-8 

 

Tab “Seat lifting” (optional) 

The Seat Lifting tab is visible if the ICM control is interconnected to an instance of 
the class "SLB" (seat lifting). Otherwise this tab is invisible.  

In this tab the additional activations of the corresponding seat lifting top and bottom 
for double seat valves can be visualized and operated. 

 

The following functions are available, while b) to f) is available for top and bottom 
mode separately. 
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a) Block symbol, signaling the seat liftings and display of the operating mode 
(manual, simulation, error) 

b) Display field seat lifting on, off, locked 

c) Command buttons On, Off, Q (acknowledge error) 

d) Monitoring time in seconds 

e) Pulse time current and setpoint in seconds 

f) Pause time current and setpoint in seconds 

g) "External" selection box for pulse/pause mode 

 

Figure 4-9 

 

Tab “About” 

If configured, the tab "About" is providing additional information’s, e.g. description, 
address and location information. Furthermore, the operator has the possibility to 
leave free configurable information’s by using the “Note” button as displayed below. 
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Figure 4-10 

 

Tabs “Extended”, “Maintenance”, “Parameter” 

The above-mentioned tabs are not in scope of a typically operator work and 
therefore not described in this document.  

4.3 Digital Faceplate 

This faceplate is used for the monitoring and simulation of digital inputs, e.g. for 
sensors, swing-bend, etc. The digital inputs will be passed through timers to 
debounce the input signals. 

 

The faceplate dialog provides three tabs: 

• General 

• Parameter (not in scope of a typically operator work and therefore not 
described in this document) 

• About 

Tab “General” 

The tab “General” gives an overview of the state of the digital inputs and outputs as 
symbol indicators and as trend display. Setting the checkbox “Simulation” allows 
simulating the input value. While the simulation is running, a red exclamation mark 
“!” is displayed to indicate that the simulation is currently active. 

 

NOTE The simulation feature should be handled with care to avoid unwanted behavior.  

 

Tab “About” 

In the tab "About", general configuration information is displayed (description, 
address, location). 
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Figure 4-11 

 

Symbolic Representation in the Process Image 

While the simulation is running, a red exclamation mark “!” is displayed to the right 
of the device symbol in the process picture. 

 

Figure 4-12 

 

4.4 Analogue Faceplate  

The faceplate is used to monitor and simulate analogue input and output values, 
e.g.  temperature or pressure measurements. 

 

The faceplate dialog provides four tabs: 

• General 

• Batch 

• Trend 

• About 

Tab “General” 

In the tab "General", the analogue values are displayed numerically and as a 
vertical bar graph. 
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Figure 4-13 

 

In the “Value” section, the current value and the limit values are shown.  

Selecting the checkbox "Simulation" will use simulated analogue values. They can 
be modified manually by direct input or through the buttons to the right of the bar 
graph: 

 

Table 4-3 

Button Effect 

 „+ +“ Large increase 

„+“ Small increase 

 „−“ Small decrease 

„− −“ Large decrease 

 

NOTE The simulation feature should be handled with care to avoid unwanted behavior.  

 

In the “Parameters” section the relevant parameters such as range, limits and flags 
can be changed if the corresponding checkbox is activated. The “Parameters” 
section is not in scope of a typically operator work and therefore not further 
explained in this document. 

Tab “Batch” 

The “Batch” tab is providing detailed information about the batch running on the 
sequence to which this ICM is assigned. 

Tab “Trend” 

The “Trend” tab is displaying a curve of the analogue value. 
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Figure 4-14 

 

Tab “About” 

In the tab "About", general configuration information is displayed (description, 
address, location). 

Symbolic Representation in the Process Image 

While the simulation is running, a red exclamation mark “!” is displayed to the right 
of the device symbol in the process picture. 

 

Figure 4-15 

 

 

Figure 4-16 

 

4.5 Controller Faceplate 

The faceplate is used to monitor and simulate PID- and Three-Step controllers. 

The faceplate dialog provides five tabs: 

• General 

• Parameter 

• Batch 

• Trend 

• About 

Tab "General” 

In the tab "General" all the relevant control values and parameters can be 
displayed and set. In the faceplate, the following variable names are used: 
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Table 4-4 

Name Meaning 

KP Proportional gain 

TV Rate time 

TN Reset time 

X Actual value 

Y Process value (output) 

W Set point 

XD Deviation actual value/set point 

 

Figure 4-17 

 

 

The “Control” area in the right part of the faceplate is divided into four sections: 

1. In the top left section, the buttons “Auto” and “Manual” toggle between 
automatic and manual operation. 

2. In the top right section, the source of the PID set point is chosen. “External” will 
use the configured value “Source”. “Internal” enables manual control of the set 
point “W” (see 4). 

3. In the “Parameters” section, the PID parameters “KP”, “TV”, and “TN” can be 
set. 

4. In the bottom area, the set point “W”, actual value “X” and process output 
value “Y” are displayed. If the intern/extern selector switch at the top (see 1) is 
set to “Internal”, then the set point “W” can also be changed here. 

Tab "Parameter" 

The “Parameter” Section is not in scope of a typically operator work. Controller 
parameters like limits, sampling, dead band, etc. can be changed here. The 
controller can be set to reverse and X-tracking.  

 If the YN flag is set the controller switches off and a fixed value defined in the 
parameter YNF is transferred to the output. In operation mode X-Tracking (XTR = 
"1") the internal target value is adjusted to the actual value of XIST. This renders 
possible a smooth transfer from external to internal tracking. If the “Reversing duty” 
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flag is set an increase of the actual value will result in a decrease of the output and 
vice versa. 

 

Figure 4-18 

 

Tab “Batch” 

The “Batch” tab is providing detailed information about the batch running on the 
sequence to which this ICM is assigned. 

Tab “Trend” 

The tab “Trend” displays trend curves for: 

• Process output value “Y”, 

• Set point “W”, and 

• Actual value “X” 

Furthermore, the controller parameters “KP”, “TV”, “TN” and the sampling time are 
displayed. 

 

Figure 4-19 
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Tab “About” 

In the tab "About", general configuration information is displayed (description, 
address, location). 

Symbolic representation in the process picture 

To display the current status of the device in the process pictures, the following 
icons are used: 

 

Table 4-5 

Icon Controller State  

 

“Manual“ 

 

“Internal“ 

 

4.6 Entity Faceplate 

The Entity faceplate is providing the following features 

• Collection of important values via templates as one dataset 

• Read-only or read-write 

• Display of value, text or bit-related text 

• Customized status display 

The faceplate dialog provides two tabs: 

• Properties 

• Status 
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Tab "Properties” 

 

Figure 4-20 

 

Tab "Status” 

The Status tab is showing bit-related text: 

 

Figure 4-21 

 

4.7 Tank Faceplate 

The faceplate manages the Tank status and provides runtime monitoring 
information’s with interfaces and messages for process and quality status, 
including an operating and monitoring interface. 

 

The faceplate dialog provides five tabs: 

• General 

• Times 

• Batch 

• Trend 

• About 
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The figure below is showing an example of the tank faceplate. 

 

Figure 4-22 

 

Tab “General” 

 

This tab features four main sections: 

1. Actual value display 

2. Control mode 

3. Tank data section 

4. Material movement section 

 

Figure 4-23 

1 2

3

4
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The individual sections contain the following displays/control elements: 

 

Figure 4-24 

1

2

3

4, 6

5

 

 

• Actual value display 

1. Visualization of up to 8 temperature zones 

2. Three standard values: avg. temperature of the temperature zones, pressure 
and quantity of the tank 

3. Display for monitoring the remaining time of the material quality after a change 
of the quality and/ or tank status. Additionally, the start timestamp of the 
change is displayed. 

• Control mode  

4. Auto/Man operation mode 
In manual mode the quality and tank status of the tank data section could be 
changed. 
A red hand symbol is indicating that the operating mode is set to manual 

• Tank data section 

5. Tank description displaying the tank name, group and type data. 
Tank status and quality status information which influencing the Quality, 
Cleaning and Sterile monitoring timers 

• Material movement section 

6. In manual mode the material and the correction quality value could be set and 
the Save Button is operable. Otherwise this information will be provided by the 
automation system. 
A gray hand/ red M symbol is indicating that Operating mode is set to manual 

Tab “Times” 

The monitoring times for the "Quality status" and for the status "Clean" and 
"Sterile" are displayed and could be activated in this tab. 

Depending on the value of the tank status and quality status the according 
monitoring time will become active. 
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The target time is displaying the set point value how long the according state 
material is valid. The remaining time is displaying the actual value until the 
according state expires. 

 

Figure 4-25 

 

Tab “Batch” 

The “Batch” tab is providing detailed information about the batch running on the 
sequence to which this ICM is assigned. 

Tab “Trend” 

The “Trend” tab could display tank values, temperature, pressure, quantity as curve 
display. 

 

Figure 4-26 

 

Tab “About” 

If configured, the tab "About" is providing additional information’s, e.g. description, 
address and location information. Furthermore, the operator has the possibility to 
leave free configurable information’s by using the “Note” button. 



4 Faceplates 

 

BRAUMAT Manual 
Entry-ID: 80142364,    V 2,    07/2019   37 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4.8 Line Faceplate 

The Line faceplate is visualizing pipeline states and provides a runtime monitoring 
function with interfaces and messages for the process status, including an operator 
and monitoring user interface for this purpose. Furthermore, the operator has the 
possibility to leave free configurable information’s by using the “Note” button. 

Tab "General” 

The “General” tab is providing the following functionalities: 

• Displaying and switching the operating mode  

• Displaying and switching the line status parameters, Name, Group and Type 

• Displaying the process status, writeable in manual mode  
The manual mode is indicated by a red hand symbol next to the line icon in the 
faceplate. 

 

Figure 4-27 

 

 

• Displaying the Monitoring time for the predefined process status 
During activated monitoring this field shown the remaining time for a 
predefined process status. The field below it contains the start time of this 
process status. After the monitoring time has expired, the field for the 
remaining runtime is colored red 

• Displaying and selecting the material used for the Material Movement 

 

NOTE After pressing the „Save“ button, the material is set or changed in the dataset. 
The revert button is grayed out and the procedure cannot be undone. 
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Figure 4-28 

 

Tab "Times” 

The monitoring time for the defined process status is displayed and activated in this 
view.  Depending on the value of the process status and the checkbox “Monitoring 
active” the monitoring time will become active. The target time is displaying the set 
point value how long the according state is valid. The remaining time is displaying 
the actual value until the according state expires and become invalid. After the 
monitoring time has expired, the field for the remaining runtime is colored red. 

 

Figure 4-29 

 

Tab “Batch” 

The “Batch” tab is providing detailed information about the batch running on the 
sequence to which this ICM is assigned. 
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Tab "About” 

If configured, the tab "About" is providing additional information’s, e.g. description, 
address and location information. Furthermore, the operator has the possibility to 
leave free configurable information’s by using the “Note” button. 

4.9 Unit Control Faceplate 

The Unit Control faceplate can be used for the operation and monitoring of a 
sequence which is assigned to one recipe unit procedure (1:1 relation). 

The faceplate is available in a small and large version. 

The faceplate can perform the following functions for a unit:  

Recipe selection, start, stop, step selection, hold, restart, manual/automatic, 
auxiliary equipment On/Off and operator prompt. 

Additionally, separate windows for the Unit Set points and the ROP Set points can 
also be viewed and hidden. 

Symbolic Representation in the Process-Image 

The "Unit Control" can be represented symbolically in several ways. 

• Line representation 

• Block icon, Unit faceplate opens by clicking the corresponding icon 

• Window representation, embeds the Unit Control directly in the process 
picture 

• Small Representation 

4.9.1 Unit Control Small 

The small representation of the unit control is providing a quick overview of the 
assigned Unit (sequence). See figure below for more information. 

 

Figure 4-30 

 

4.9.2 Unit Control Large - Line representation 

The line representation of a unit control appears as below: 

 

Figure 4-31 
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From left to right, the individual control components have the following functions: 

 

Table 4-6 

Icon/Display Function Note 

 

Display sequence-related 
actual values /set points 

 

 

Automatic/Manual Mode 
Switch 

 

 

Start sequence 

 

 

Stop sequence 

 

 

Resume sequence 

The sequence is resuming from a former 
Hold command. 

 

Hold sequence 

The currently executed step is set to hold. 
The recipe unit procedure does not proceed 
to the next step. Depending on the 
configuration of the project Pumps and 
valves remain active. 

 

Manual Step-Selection 

A dialog opens which allows the manual 
selection of the next step: 

 

Operator request 
acknowledge 

A dialog opens which allows the 
acknowledgment of an operator request, see 
chapter. 5.3.4 for more information’s. 

 

Switch additional Device 
on or off 

 

 

Sequence name, number 
and status 

Sequence status (idle, running, hold ...) 

 

Sequence displays  

 
Auto / manual – mode 

 

Switch to next step / stop after current step 
finished 

 
Synchronization met / waiting  

 
Alternative met / not met 

 
Permanent condition missing 

 
User flag active / inactive 

 
Operator request is active 

 
EOP monitoring time expired 
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Icon/Display Function Note 

 
Recipe load error 

 
Error / Warning / Process Message active   

 

Step-related actual 
values/set points are 
shown 

Possibility to change the set point values 

 

 

Step-related information 

A) Current number of recipe operation 

B) Absolute EOP number in the PLC 

C) Current Step Name (EOP name) 

D) Current Step running time 

 

Batch-related information 

A) Current order number 

B) Current batch number 

C) Current recipe category name 

D) Current master recipe name 

 

NOTE Changing the set points for the current batch will only affect the current 
batch. For the next batch, the values from the Master recipe will be used 
again. 

 

Block Icon 

To open the “Unit Control Large” faceplate, click on the sequence icon in one of the 
process pictures. 

 

Figure 4-32 

 

 

The Unit Control opens as window and displays the most relevant process 
information’s. Additionally, it allows the basic control of the unit. See next section 
for details. 



4 Faceplates 

 

BRAUMAT Manual 
Entry-ID: 80142364,    V 2,    07/2019   42 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Unit Control Large - Window representation 

The line representation of a unit control appears as below: 

 

Figure 4-33 

 

 

From left to right, the individual control components have the following functions: 

Table 4-7 

Icon/Display Function Note 

 

Opens the application 
“Sequence Control“ 

See chapter 5.3 for more information 

 

Permanent condition 
(Sequence Interlock) 

Depending on the configuration a BLR 
Object or S7-Status Dialog is displayed 
which helps the operator to identify the 
root cause of the interlock, refer to 
chapter 3.12  for more details. Note: In 
case that the sequence is processed by a 
S7-1500 PCU and no BLR Object is 
configured the following message will be 
displayed: 
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Icon/Display Function Note 

 

Switch additional device on or 
off 

 

 

The order number, batch 
number, recipe and category 
of current batch running on 
the unit 

 

 

Opens the application “Online 
recipe” 

 

  
 

See chapter 5.4  for more information 

 

Opens the order parameter 
list  

See chapter 5.2 for more information 

 

Sequence-related set points 
and actual values are 
displayed 

If Needed, set point value could be 
changed in this dialog for the online 
recipe. 

 

Sequence display and control 

For element description see chapter 4.9.2 

 

Step display and control 

Commands for recipe operation: 

Continue, Hold, Pause, Stop, Termination 

 

 

Display of next-step-condition 
logic 

Depending on the configuration a BLR 
Object or S7-Status Dialog is displayed 
which helps the operator to identify the 
root cause of the interlock, refer to 
chapter 3.12  for more details 
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Icon/Display Function Note 

 

Step related set points 

Possibility to change the set point values 

 

 

NOTE Changing the set points for the current batch will only affect the current 
batch. For the next batch, the values from the Master recipe will be used 
again. 

 

4.10 Date-Time Control 

The Date-Time control is providing a clock which could be displayed in analogue or 
digital representation. Typically, the Date-Time control is located on the Top right 
Pane of the Process Screen. 

Furthermore, it is possible to display/change the current BRAUMAT / SISTAR user 
by clicking on the User button of the control. 

 

Figure 4-34 
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5 Batch and Order System  

5.1 Introduction 

The BRAUMAT / SISTAR system offers the Order Management for creating, 
starting and monitoring orders and batches.   

5.2 Order Management 

The Order Management has the task of processing a list of batches. This list can 
be created, either by the ordering system on the IOS, e.g. by the operator, or by a 
higher-level system (MES). Basic tasks of the Order Management are to schedule 
the orders, rearrange the order sequence, changing order parameters or changing 
the order sequence of the batches. In addition, the progress of batch processing 
can be tracked online, e.g. by jumping directly to the linked specific online recipe. 

Alternatively, it is possible to directly start, control and monitor the recipes for 
individual Units with the usage of the Sequence Control. 

The Order Management can be found in the "Production" tab in the Application 
Center, indicated by the following icon: 

 

Figure 5-1 

 

5.2.1 Structure of the User Interface 

The Order Management is divided into several views. 

 

Figure 5-2 

 

The Left Tree Pane (blue frame) 

Gives an overview of all available order categories with their assigned orders. From 
this panel it is also possible to switch between current and archive view (see 
bottom).  
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The Middle Pane (green frame)  

This is tab-oriented and can contain multiple worksheets. A worksheet shows the 
filtered batch list or the unit allocation to the batches as per the selection in the 
navigation area.  

A new worksheet can be added by Select “Menu > File > New Batch List” or “New 
Unit allocation” or using the Toolbar Elements (green Frame). 

• Selection root node "Production <AREA x>" → all batches of this AREA are 
displayed  

• Selection order category → all batches/all orders of this order category are 
displayed 

• Selection order → all batches of this order/these orders are displayed 

Additionally, it is possible to move a batch to a new table position, e.g. to change 
the execution order of the created batches.  

To do this, select a batch from the list. By dragging (left mouse button) the batch to 
the new table position, a dialog opens which presents the source and target 
position. By confirming the query, the selected batch is moved and the processing 
order will be changed.  

The Right Pane (orange frame)  

This is showing all Order Parameters of the selected batch. 

5.2.2 Open Order/Batch related Applications 

Select one batch from the “Batch list” or “Unit list” to jump directly to further batch 
related applications which will provide further information’s and traceability 
regarding the running process. 

From the “Menu > File” you can navigate directly to every order/batch related 
application. 

 

Table 5-1 

Application  Shortcut 

Process Parameter 
Editor (Recipe Offline) 

 

Strg+F7 

Process Cell Overview 
(Sequencer), see 
Chapter 5.3 

 

Strg+F8 
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Application  Shortcut 

Control Recipe (Recipe 
Online), see Chapter 5.4  

 

F9 

 

5.2.3 Creating a new Order  

The following procedure describes how to create a new order. The described 
procedure can vary depending on the on-site requirement. Open the Order 
Management and right click from the given Order Categories and select “New 
Order”. Alternatively select “Strg+N“ or use the menu edit. 

 

Figure 5-3 

 

 

The “Enter New Order” Dialog appears where the order can be configured. 

The Dialog is divided into several areas which are described afterwards. 

The following figure is showing the “Enter New Order” Dialog. 
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Figure 5-4 

1

2

3

4

5

 

 

1. “Recipe Data”: In the “Recipe Data” area, the operator can select the recipe for 
the new order and if enabled the line and product 

2. “Batch ID”: If enabled, the operator can define the year, order number and the 
first batch number for this order.  

3. “Start”: If enabled, the operator can select the start options for the new order 
e.g. immediately after creation 

4. “Batch Generation”: If enabled, the operator can define the amount of 
produced material (Order size) and/or the number of batches per order. 

 

NOTE The calculations of how many batches per order are created by the system and 
the size of the individual batches are depending on configurable algorithms! 

 

5. “Order Parameter”: If “Order Parameters” are configured for the recipe the 
values can be customized if needed. 

 

Figure 5-5 

 

 

By clicking into the setpoint field a further Dialog opens where you can add the 
value. 
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Figure 5-6 

 

 

NOTE If an order is divided into multiple batches the inserted value is used for all 
batches. 

 

The values for each batch can be changed if needed as displayed on the right-
side figure 

5.2.4 How to release a Batch from a Batchlist 

Depending on the project configuration of the “Default Batch Status”, an order can 
be “locked”, “ready for release” or “released”. If the batch state is “locked” or “ready 
for release”, the operator need to Release it first before the Order Management can 
queue the batch and start it. 

To release a batch, you need to select it from the batch list first. From the context 
menu (right click) select release. Alternatively select “Edit > Release” from the 
Menu Bar.  
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Figure 5-7 

 

5.2.5 How to start a Batch from a Batchlist 

Starting batches depends on the configured start mode. The Order Management 
has no start or play button. The starting mode can be changed from the context 
menu (right click) as long as the status is not “Started” and the concerning starting 
modes are enabled for the Order Category.  

In general there are four different starting modes available.  

1. “As soon as possible”  
The batch is started as soon as the required “start unit” is free, in automatic 
mode, not stopped and not disabled and the batch is released. If several 
batches are released and are waiting for the same unit, the topmost batch in 
the list is started. 

2. “By event” 
Order start is triggered by the Automation system. 

3. “By time” 
The batch is started when the batch start time is reached or exceeded and the 
unit itself is not occupied. 

4. After time/auto” 
This start mode is like start mode “by time” with the exception that the start 
times of the follow-on batches are automatically adapted if there are delays in 
starting the batch. This adaptation is only for batches with this start mode and 
batches that have the same “start unit”. 

5.3 Sequence Control 

The Application “Sequence Control” can be found in the "Production" tab in the 
Application Center, indicated by the following icon: 

 

Figure 5-8 
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Basically the application “Sequence Control” is used to control and monitor the 
units in the process cells. With that the user can intervene in the current process 
and influence the different processes. 

5.3.1 Structure of the User Interface 

The Sequence Control is divided into three areas. 

 

Figure 5-9 

 

The Top Pane (blue frame) 

This pane is displaying the sequence table which lists all sequences with additional 
information’s like sequence status, EOP status, recipe and order information. 
From the “Menu bar > Options” it is possible to display only the running sequences. 

The Middle Pane (green frame) 

This pane is showing sequence and step related set point data.  

The Bottom Pane (orange frame) 

This pane is showing sequence related messages. 

5.3.2 Start, Stop, Hold, Resume a Sequence 

 

CAUTION 

If order parameters are used in the recipe then the default value is loaded 
when you start the recipe via the sequencer, e.g. Value “0”. This can lead 
to unwanted behavior! 

 

The following list gives an introduction of the basic operations for a sequence. All 
the tasks shown here can be also carried out from the Unit Control faceplate in 
Process Runtime. 
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1. Select the desired Process Cell from the menu bar “Process-cell”.  

 

Figure 5-10 

 

 

2. To start a sequence, select the desired sequence from the available process 
cells and press the “Start” button from the Toolbar. If more than one recipe is 
available for this sequence, a dialog box opens and the operator needs to 
select the recipe of interest. 
After you press the Start button the sequence will become active. 

 

Figure 5-11 
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3. To abort a sequence, press the Stop button from the Toolbar. 

 

Figure 5-12 

 

 

4. To hold a sequence, press the Hold button from the Toolbar (“-“ Symbol). 

 

Figure 5-13 

 

 

5. To resume a sequence, press the Resume button from the Toolbar 
(“+” Symbol). 

 

Figure 5-14 

 

5.3.3 Changing Setpoint Values in the Online Recipe  

With BRAUMAT / SISTAR it is possible to change setpoint values of the active step 
of the respective online recipe. To change setpoint values open the corresponding 
Unit Control faceplate or change the setpoint values directly from the Sequence 
Control Application. The change is valid only for this batch. For the next batch the 
original recipe parameter set point values are used again. 

 

Change Setpoint Values from the Unit Control faceplate: 

 

Figure 5-15 
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Change Setpoint Values from the Sequence Control Application: 

 

Figure 5-16 

 

5.3.4 Operate and Acknowledge Operator Requests 

In order to inform the plant operator about a manual operating instruction, the 
BRAUMAT / SISTAR System uses so called Operator Requests. The Operator 
Requests are indicated by a “Hand” Symbol in the Unit Control or Sequence 
Application. 

Depending on the configuration of the Operator Requests, the operator must either 
acknowledge the dialog without entering a Setpoint Value or he must first  
entering a Setpoint Value and acknowledges the request afterwards. 

The figure below is showing an example of an Operator Requests displayed in the 
Sequence Application. 

 

Figure 5-17 

 

5.3.5 Order and Batch Numbers 

Order and batch numbers are needed to: 

• plan a process (for example filtration) 

• get a report as a step protocol 

• Tracking and Tracing of Material 

When a process is started by the batch list the system will automatically increase 
the batch number or order number (depending on the selected algorithm). One 
order can contain one or more batches with different batch numbers and can be 
therefore seen as a grouping element. In a Brewhouse for example, the batch 
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number can count up for one year and then restart. Order number can be 
automatically increased or derived from the calendar week. 

If batches are started manually via Sequence Control or the Unit control faceplate 
or from inside the PLC with a special-order start block (“ASTA”) it is possible to use 
the same batch ID more than once. Although it may be necessary to manually 
restart a batch, e.g.  after an error. This may lead to a situation that all of this the 
production data is assigned to the same batch. 

Therefore, the manual assignment of Batch IDs must be done with a maximum 
attention. 

 

A complete ID of a batch consists of the following parts: 

• Site number 

• Area number 

• Recipe category 

• Batch year 

• Order number 

• Batch number 

 

This is because a BRAUMAT / SISTAR installation may span over multiple areas of 
a site and even more than one site. 

 

NOTE If one of the above-mentioned ID parts is not considered when manually creating 
a batch, the generated batch data can only be identified clearly by their time 
stamps. 

 

5.4 Online/Control Recipe  

The task of the control recipe visualization function is to visualize the processing 
steps of control recipes which were generated by the recipe system and 
downloaded to the PCU. Based on the recipe procedures, the recipe system 
generates the control recipes by substituting the process/order parameters with the 
current master recipe/order parameters.  

When the recipe procedure contains weighing recipe operations, the control recipe 
dynamically generates weighing and interim draining operations, depending on the 
volume of process input materials to be weighed.  

The online recipe can be found in the "Production" tab in the Application Center, 
indicated by the following icon: 

 

Figure 5-18 

 

How to open the Online Recipe 

The following options are available to open an online recipe. 
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• Open the online recipe from the Application Center directly. 

 

Figure 5-19 

 

 

• Open the online recipe from Order Management. 
Select a running batch from the batch list and double-click on it or press “F9”. 

 

Figure 5-20 

 

 

• Open the online recipe from the Sequence Control Application. 
Select a started sequence from the Process Cell List and press “F9”  

 

Figure 5-21 
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• Open the online recipe from the Unit Control faceplate. 
Therefore press the button “Current recipe” displayed on the figure on the right 
side. 

 

Figure 5-22 
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6 Graphic system – Display and Operation 

6.1 Process Images, Visualization 

The application “process diagrams” offer a plant overview based on the configured 
full graphic images by viewing process data from the Automation system. Via 
control elements, the user can control the running process and access the different 
sequences. The following chapters give an overview to the operator how the 
navigation can be done easily and efficiently. 

6.2 Navigation 

6.2.1 General Navigation in the Process Diagrams Application 

There are various means to navigate between the pictures of a project: 

• From the Menu bar, click the “General Overview” menu to navigate to the start 
screen. Typically, the start screen is showing the whole Plant Overview, give a 
quick overview over the major elements and give the possibility to navigate 
quickly to the several areas. 

 

Figure 6-1 

  

 

• From the Menu bar, click the “Open process diagram” menu to open the 
process picture of interest from the Picture Tree.  

 

Figure 6-2 
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• If configured in the project, you can use the navigation buttons, displayed on 
the Figure on the right, to jump to the specific process picture.  

 

Figure 6-3 

 

 

• To move back to the previously opened process picture, click on the icon 
highlighted to the right, or use the keys "Ctrl” + “F12". 

 

Figure 6-4 

 

6.2.2 Navigation Panel 

The system provides a panel faceplate which allows you to navigate through the 
process pictures and areas. Typically, the Navigation Panel is located at the bottom 
of the process screen, see chapter. 3.6. The following schema illustrates the 
hierarchical Process picture tree which is divided into 3 levels. With the navigation 
panel you can navigate through the Tree. Additionally, it is possible to open further 
BRAUMAT / SISTAR applications, e.g. the Trending System or Order 
Management. 
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Figure 6-5 

 

 

The following table describes all elements from the navigation pane. 

 

Table 6-1 

Icon Action 

 

Navigate to the Start Picture: 

Left click the Home button from the Navigation Panel. 
The name of the start picture is displayed by right click 
the home button  

 

Navigate to previous/next PCell: 

Left click the “Previous” (arrow left) or “Next” (arrow 
right) button to navigate directly to previous or next 
PCell from the Hierarchy Tree. Right click to see all 
available PCell’s in the project. The actual displayed 
PCell is marked by 2 angle brackets 

 
 

 

Navigate to previous/next image: 

Left click the “Previous” (arrow left)  or “Next” (arrow 
right) button to navigate directly to previous or next 
Process Image within the current PCell.  

Right click to see all available images within the PCell. 
The actual displayed picture is marked by 2 angle 
brackets  
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6.2.3 Printing of Process Images  

To print the view of the currently opened process picture with the online values, do 
one of the following: 

• Click on the highlighted printer symbol icon, press „CTRL + P“ on the 

keyboard, 

 

Figure 6-6 

 

 

or 

• Select the menu item “File > Print“. 
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7 Logging system - Analysis of processes 

7.1 Step Protocols 

The application “Step Protocols” is used to display and print a list of step protocols. 
Chronologically the set points and actual values occurred during processing of the 
units such as 

• times,  

• quantities,  

• temperatures, etc.  

• information about the executed equipment operations  

are stored.  

The application can be found in the "Archives" tab in the Application Center, 
indicated by the following icon: 

 

Figure 7-1 

 

7.1.1 Open a specific protocol  

To open a Step protocol select “File > Open” from the menu or click the 
corresponding button       from the Toolbar. 

In the dialog “Select step Protocol” the available step protocols can be selected by 
year, recipe category, order number, batch number and unit. 

When all selections are made and the “OK” button is pressed the step protocol is 
displayed.  The screenshot below is showing the “Select step Protocol” dialog. 

 

Figure 7-2 
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The following figure is showing the elements of the Step Protocol: 

 

Figure 7-3 

 

 

NOTE The Step Protocol is displaying data for one Unit. 

7.2 Batch Trends – Curve Output 

The system can log measurements of specific values over a certain period, 
creating so-called “Trends”. These curves can be displayed with the application 
"Curve Output". The values which should be archived and displayed within the 
trend need to be defined by the engineering team in the application "Trending 
definition" from the tab “Engineering-Tools” first. 

The application can be found in the "Archives" tab in the Application Center, 
indicated by the following icon: 

 

Figure 7-4 

 

7.2.1 Types of Trends 

BRAUMAT / SISTAR supports three types of trend curves: 

• Short term trends: User-selected collections of trend curves which are not 
stored on the hard disk. The values are stored in a cyclic buffer in the memory 
and will be overwritten permanently when the buffer exceeds. 

• Weekly archives (stored on hard disk) are running cyclically in the scope of the 
current week. 

• Batch archives (stored on hard disk) typically displaying trends in scope of a 
batch, e.g. the logging is enabled when the batch starts and disabled when the 
batch ends.  
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7.2.2 Features of the Trend display 

• Each trend group file (a so called “Trend Picture”) may contain up to eight 
analogue and sixteen digital curves with their units in one picture. Each curve 
can be individually shown or hide. 

• The operator can print views of the curves. 

• A zoom function allows a deeper and more accurate analysis of the trend 
values. 

• A ruler shows the exact process values and time. 

• The scaling of the curve, physical units etc. are configured in the application 
"Trending definition". 

7.2.3 Selection of Trends 

To display a trend open the “Batch Trends” application. From the menu select “File 
> Open” and the archive type of interest.  

 

Figure 7-5 

 

 

Alternatively you can use the corresponding buttons from the toolbar. 

 

Figure 7-6 

 

The “Open Image” dialog opens were the operator can select the image of interest 
and the options for display. 

 

The following options are available: 

• Normal View: The measured values are related to a batch ID. In a second 
step the user selects the batch ID. 

• Compare Curves: The curve of the current batch is compared to the curve 
of a previously saved batch. Again, the user selects the batch ID in a 
second step. 

• Free Selection: It is possible to visualize up to eight batch curves in a 
single display. The selection is specific to the measured value and will be 
used as reference for the selection “reference curves”. 
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The figure below is showing the scenario how to configure a normal view for a 
Batch Archive. Select the year, recipe category, order and batch number from the 
Batch Selection dialog and press the OK button afterwards. 

 

Figure 7-7 

 

 

7.2.4 Working with the Trend Display 

The Trend Display is providing the following functionality 
 

• Zoom In  

To zoom into the Trend Area press and hold the left mouse button, drag the area of 
interest and release the mouse button. 

NOTE The Ruler must not be activated to use the zoom function 
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• Show/Hide individual curves 
To show/hide individual curves just click on the curve name on the upper left 
pane of the Trend Display. To display all curves you can use the button              
from the toolbar. 

 

Figure 7-8 

 

 

• Ruler 
To enable/disable the Ruler functionality, just click on the button from the 
toolbar. 

 

Figure 7-9 

 

 

• Print 
To print out the collection, e.g. as a pdf file, just click on the printer button from 
the toolbar. 

 

Figure 7-10 
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8 Message system  

8.1 Alarm System 

8.1.1 Overview 

The Message and Alarm System provides information’s about operating states and 
system or process faults within the process. This allows the operator to detect 
critical situations at an early stage and avoiding errors and failures.  

For each message separate texts for incoming and outgoing messages are 
available. Additionally, the messages will be archived on the hard disk of the 
BRAUMAT / SISTAR Server. The messages and alarms can be displayed on 
several ways. 

• The Application „Message archive“ is displaying archived messages. 

 

Figure 8-1 

 

 

• The Message Control faceplate is displaying messages in the process images. 

 

Figure 8-2 

 

 

NOTE With the Message Control faceplate, it is possible to configure filter settings. 
Therefore, the output can vary in different projects depending on the project 
requirements. 
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• The application „Sequence Control“ is displaying Unit related Messages. 

 

Figure 8-3 

 

8.1.2 Message Classes and Types 

There are different classes and types of messages in the BRAUMAT / SISTAR 
system available which are displayed in the following table: 

 

Table 8-1 

Message 
Class 

Description Message 
type 

Description Color 

E Error/failure F User fault message Violet 

  S System fault message Red 

W Warnings W Warning Orange 

M Process Messages M User status message Green 

  B Operator message Blue 

O Operation Request O Operation Request Dark green 

 No Class P IOS Message Light Brown 

8.1.3 Reset Messages 

The application “Sequence Control” can be used to reset the Error, Warnings and 
Process Messages, which are displayed in the following figure. 

 

Figure 8-4 
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To reset the messages within the Process Picture the Unit Control faceplate can be 
used. 

 

Figure 8-5 

 

8.1.4 Loop in Alarm 

You can use the following applications to jump directly from the message into the 
responsible source object in the process diagram (Loop in Alarm). 

• Message faceplate from the Process Picture 

• Application Sequence Control 

• Application Message Viewer (Archive) 

 

This can be done by double-click into the message of interest or by using right click 
and select “Goto Process Diagram”. 

8.2 Message archive 

The application allows you to display and print  

• messages  

• process operations 

• changelogs  

• configuration changes  

within a selected time period. You can add your own filter criteria and column 
settings for searching and displaying the associated archive files for the selected 
type and period (based on days). It is also possible to sort the archive files by 
column within this context. 

The currently selected settings for archive selection, column selection and sorting 
are saved for the next call of the application. 

 

1. Open menu “Archives > Changes and messages" 

 

Figure 8-6 
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2. From the Archive Viewer tick the “Messages” checkbox and specifying the 
report period by double-click the begin/end date fields in the main view or 
select the Open button from the toolbar. 

 

Figure 8-7 

 

 

3. To filter the output data, select the “Filter Output“ button from the toolbar. 

 

Figure 8-8 

 

 

4. Set the filter of interest and click OK. 

 

Figure 8-9 

 

 

NOTE The batch number must be padded with leading zeroes. E.g. to filter for the batch 
number “3” enter “000003”. 
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8.3 Change Protocol 

All user activity is logged together with the user ID in the change protocol. 

The Change Protocol can be opened from the Message Viewer like the Message 
Archive, see above. 

From the Archive Viewer select “Changes” instead of Messages and specify the 
report period by double-click the begin/end date fields in the main view or select 
the Open button from the toolbar. To filter the output data, select the “Filter Output“ 
button from the toolbar. 

 

Figure 8-10 
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9 Replay Mode 

9.1 Introduction 

The main scope of the Replay mode is to identify error statuses that occurred in the 
past. Those events can be totally and conveniently observed and localized in terms 
of their origins and their potential effects. 

9.2 Starting the Replay Mode 

The Replay Mode can be started from the Process diagrams application. 

In the title bar navigate to Options and activate the Replay Mode. Alternatively, you 
can activate/deactivate the Replay Mode from the symbol bar by clicking on the 
camera button.  

 

Figure 9-1 

 

 

After the Replay mode was activated, an additional operator panel is displayed at 
the bottom edge of the process diagram that allows the following input: 

• Preselection of the replay time (date, time) 

• Slider for fast changing of the replay time (min:sec)  

• Entry of the replay interval (in sec where n = 1 ... 60) 

• Stop / Pause buttons 

• Jump Forward/Backward buttons 

 

Figure 9-2 

 

 

9.3 How to Preselect the Starting point for the Replay 
Mode 

Additionally, the Replay Mode is intended to help the operator to identify 
exceptional statuses or events quickly. Therefore, it is necessary to establish a 
simple and intuitive connection between the specific event (signal/status in the 
process diagram or message in the message window or message archive) and the 
replay time.  

The next chapter describes typically uses cases how to preselect the Replay Mode 
with the time stamp when the specific event occurred, e.g. an Alarm Message. 
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9.3.1 Setting the Replay Time via process picture 

1. Select the object of interest from the process picture, e.g. a valve or pump. 

2. Right click on the object and select “Operations and Messages”. 

The archive viewer appears and is showing messages of the selected object in the 
scope of current day. For changing the display period see .8.2. 

3. Select the message of interest, right click and select “Set Replay Time”.  

 

Figure 9-3 

 

9.3.2 Setting the Replay Time via message system 

Similar to the previous use case it is possible to set the Replay Time from a 
specific message in the message archive directly, see also chapter 8.2 Message 
archive 

1. Open the Archive Viewer and define your display period by select “File > 
Open”. 

2. Define additional filter settings if needed by select “View > Filter settings”. 

3. Select the message of interest, right click and select “Set Replay Time”. 

4. Setting the replay time from a specific message in the message view control. 

5. Select the message of interest, right click and select “Set Replay Time”. 

 

Figure 9-4 
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9.3.3 Setting the Replay Time via batch archive 

1. Open the “Order Management” from the Application Center 

2. From the left navigation pane select the “Archive” List from the bottom to 
display all finished batches. 

3. Select the “Year” and the Order Category of interest 

4. Select the Order of interest, right click and select “Set Replay Time” 

 

Figure 9-5 
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10 Route Control System 

10.1 General information 

The route control system (“RCS”) is primarily a tool by which the planning, 
processing and the diagnosis of routes can be performed in environments with 
many different routes, like in the tank farm of a brewery. It allows controlling and 
monitoring in an easy and transparent manner. 

10.2 Switch RCS servers 

In a redundant RCS server environment, only one RCS server could be active at 
one time. The server can be set to “Active” like the recipe server.  

In order to switch over from one server to another, the menu “Program > Activate 
Route Control of PCU-Server” should be selected. You can also click the icon from 
the PCU-Server toolbar which is displayed in the figure below. 

 

Figure 10-1 

 

 

The RCS server status (active/passive) is displayed through an icon in the PCU 
Server. The RCS server is starting up properly, if all connections are established 
for each PCU. This can be checked with the PCU-Server, navigate to "Options" ► 
“route-control". 

 

Figure 10-2 

 

 

By selecting the tab "PCU" all configured connections are displayed. 

 

Figure 10-3 
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All PCUs must be in the state "server" to be able to receive telegrams. If this is not 
the case select the command “Restart” from the menu "Functions". 

 

NOTE If the PCU was in "stop" mode or the power supply was off a restart of the PCU-
Server is always required. 

 

10.3 RCS Online 

The RCS Online application consists of two sections 

• The Route view offers an overview of Routes which are created in the 
engineering tool 

• The view of the participating elements or request details of the selected Route. 

Route view 

Route view displays all projected routes and their current states. 

• Inactive: white 

• Requested: yellow 

• Active: green 

• Error: red 

 

Figure 10-4 

 

 

The selected Route can be controlled manually with the buttons from the toolbar or 
from the menu “Control” 

 

Figure 10-5 

 

Route Settings 

Open the property dialog from the menu “Control > Route Settings”. 
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NOTE Changes via the property dialog will only be allowed if the Route is in manual 
mode and not requested or active. 

  

On this tab, parameters for source, via 1…10 and destination are located. The 
display of the locations results in a tree view, which views the plant hierarchy and 
distinguishes between Process Cell/Unit-related locations and so-called general 
locations. 

 

Figure 10-6 

 

 

Details view 

The second part provides information about the elements and their states of the 
selected route in “Elements View”. 
The “Modes View” is providing information’s regarding the configured modes and 
their respective states. 

 

Figure 10-7 
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The symbols used for the Element types are described in the following table. 

 

Table 10-1 

Symbol Element Type 

 
Control 

 
Sensor 

 
Parameter 

 
Link 

 

In manual mode, activation and deactivation of modes is possible. 

 

Figure 10-8 

 



10 Route Control System 

 

BRAUMAT Manual 
Entry-ID: 80142364,    V 2,    07/2019   79 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Diagnostic for route request errors 

The cause of request errors is displayed in the view of request details. 

 

Figure 10-9 

 

10.4 RCS Faceplate (for route control) 

The faceplate is used to display and control the status and operation of the routes 
for one function ID. 

Icon representation of the RCS Faceplate in process picture 

 

The current status of the route is indicated by a symbol in the detailed view: 

 

Table 10-2 

Icon Route state 

 

Route is in state "idle" (inactive) 

 

Route is requested (the route is checked) 

 

Route is ok and active (control elements are checked and 
activated) 

 

Route is in stop (route is still active, outputs are not active) 

 

Route is active, but an error has occurred 

 

Route is in manual mode 
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NOTE Hover with the mouse pointer over the RCS icon to receive a tool tip with 
detailed information about the current element. 

 

 

RCS Faceplate dialog view 

This faceplates dialog view consists of three sections, from top to bottom: 

• Route view 

• Element view 

• Message view 

 

Figure 10-10 

 

 

Table 10-3 

View Screenshot Note 

Route view 

 

In this view the active routes 
are displayed. 

The full name of the 
element, name of source 
and destination are 
displayed as tool tips. 

Element view 

 

The element view is like the 
element view of RCS-online 
tool. 
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View Screenshot Note 

Element view 
(filtered 
output) 

 

For diagnostic a filter can be 
set to display only the faulty 
elements. 
Click the funnel icon on the 
window.  

Message view 

 

In the message window 
alarms are shown that 
originated in the plant 
section of the selected 
route. 

Filtering by clicking on the 
funnel icon reduces the 
displayed error messages 
again. 

 

10.5 RCS Troubleshooting 

This section deals with problems which can occur in connection with step 
processing. 

10.5.1 Process hangs because of Route Errors 

NOTE If a plant unit does not step to the next step although the error is acknowledged, 
then probably the activated route is not working properly. 

 

Open the RCS-faceplate dialog and navigate to the faulty route element. 

 

Figure 10-11 
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A double click on the faulty route element will directly open the process picture 
where the element is located.  From there the operator can analyze the Control 
Element. 

 

Figure 10-12 

 

10.5.2 Acknowledge Alarms of RCS 

NOTE The route error must be acknowledged after correction of the faulty element. 

 

Set the route to manual mode and acknowledge the error. 

 

Figure 10-13 

 

 

The Route will be restarting after the error was acknowledged and can be switched 
to automatic again. 
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Figure 10-14 
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11 Troubleshooting 
This section gives you a few hints to solve simple troubles which may occur during 
operating of the process. 

11.1 Problems starting a Unit 

If the sequence of a plant unit doesn’t start up properly check the following points: 

• The sequence-status must be "A" (automatic) and "+" (step forwarding active). 
(see note 1 in the figure below) 

• In case that an order parameter is used in the recipe, the sequence can only 
be started from the order system. When trying to start the sequence directly a 
“Recipe load” error will appear in the message system. 

• The permanent condition must be ok. If the object is displayed in red. 
The system is locked and can't be started.  
 

Figure 11-1 

 
 

When pressing the button “permanent condition” (see note 2 in the figure 
below) the “Binary Logic Result” dialog opens (see note 3 in the figure below) 
which is displaying the reason of the lock. 

 

Figure 11-2 

 

 

11.2 Sequence Control Issues 

If the program doesn’t proceed with the next step, the operator should check if all 
transition conditions, the so called “Next Step Condition” are successfully fulfilled. 
Typical errors are quantities which are not yet reached their set point values, 
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Synchronization Lines which are not yet reached or tanks which are not yet empty, 
etc.  Depending on the configuration of the project the following procedure differs. 

 

• In case that the Next Step Condition was engineered with a binary logic result 
object you can use the following procedure. 

– Open the corresponding Unit faceplate and press the button “Next Step 
condition”, the BLR dialog opens 

– Check which logically element was not fulfilled the condition 

 

The example below is illustrating the scenario. In the example 1) the dosing of 
“Sparging water” is not finished yet. Therefore the “Next Step Condition” is not 
valid. In the example 2) the dosing of “Sparging water” is finished and the “Next 
Step Condition” is valid. 

 

Figure 11-3 

 

 

• In case that the automation layer was engineered with Step 7 classic and no 
“Binary Logic Result” Object was configured as next step condition, you can 
use the following procedure to identify why the next step condition will not 
become active. 

– Activate the S7-Code viewer of the relevant basic operation with the 
"Detail" button in the Unit faceplate. 

– Use the "+" button to go to the last network. 

– The display shows the relevant commands for the transition condition. 
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The example below is illustrating the scenario. 

 

Figure 11-4 

 

 

In case that the Next Step Condition is fulfilled but does not proceed the Sequence, 
the operator can check the following items from the list below: 

• Is any transition condition (temperature, time) not fulfilled? 

– Chose the sequence and select “Program”, “Step-on-condition” or press F4 
to see the transition conditions. 

• Is there an operator request pending? 

• Is the program waiting for another sequence (synchronization line)? 

– Check the corresponding icon in the Sequence Control Faceplate as 
displayed in Figure 11-5 

– Or check the corresponding online recipe.  

▪ Select the correct sequence from the Sequence Control and press F9.  

▪ Or press the corresponding Button from the Faceplate.  

The graphical recipe will come up and synchronizations are displayed. 

 

Figure 11-5 
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• Are there relevant entries in the Alarm list? 

• Is the sequence in "automatic" mode? 

– The automatic mode of the sequence must be set to “A” in the column 
"Status”. 

• Is the Step set to hold, indicated by status “A –“? 

– In that case the “Status” column must be set to "+". 

• Are there any error messages from one of ICM's used in this area? 

 

11.3 Troubleshoot Recipe Server 

In case of a redundant server configuration there is an “active” and a “passive” 
recipe server. The recipes are stored on both servers but only one server will 
download the control recipes to the PCU when starting an unit. A recipe-load error 
may occur if both recipe servers having the status “passive”. In that case the recipe 
server can set to status “active” manually.  

To identify and change the state of the recipe navigate to the PCU Server and 
check the corresponding symbols in the toolbar. 

 

NOTE The PCU Server must not be closed. Otherwise the connection to the process 
will be lost! 

 

The PCU Server can be found in the Taskbar indicated by the following symbol 

 

Figure 11-6 

 

 

By clicking on the symbol, the PCU Server Dialog appears on the foreground. 

 

Figure 11-7 
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The icons are explained in the following table 

 

Table 11-1 

Icon Note 

 

The recipe server has the state “active”. 

 

The button to activate the Recipe Server is grayed out in that 
case. 

 

 

By pressing the button “Activate the Recipe Server” a further 
dialog opens. By pressing the “Yes” Button the Recipe Server 
will become “Active” 

 

 

NOTE If configured an automatic switch-over of the recipe servers occurs when the 
active server fails. 

 

Troubleshooting 

The recipe server can only operate properly when all of the following conditions are 
met, see also Figure 11-4. 

• All connections must be established for each PCU in the PCU-Server. (To 
verify this, switch the PCU-server with the pull-down menu to "View", "coupling-
status".) 

• The connection state for the PCUs is green. 

• The network cables must be connected properly. 

• The PCU must not be in state "STOP". 
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12 Appendix 

12.1 Service and Support  

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio. 

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, application examples and videos 
– all information is accessible with just a few mouse clicks at: 
https://support.industry.siemens.com 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers  
– ranging from basic support to individual support contracts. You send queries to 
Technical Support via Web form: 
www.siemens.com/industry/supportrequest 

Service offer 

Our range of services includes, inter alia, the following:  

• Product trainings 

• Plant data services 

• Spare parts services 

• Repair services 

• On-site and maintenance services 

• Retrofitting and modernization services 

• Service programs and contracts 

You can find detailed information on our range of services in the service catalog: 
https://support.industry.siemens.com/cs/sc 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for Apple iOS, Android and Windows 
Phone:  
https://support.industry.siemens.com/cs/ww/en/sc/2067 

 

12.2 Related literature 

Table 12-1 

 Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Download page of this entry 
https://support.industry.siemens.com/cs/ww/en/view/80142364 

https://support.industry.siemens.com/
http://www.siemens.com/industry/supportrequest
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/en/sc/2067
https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/80142364
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12.3 Change documentation 

Table 12-2 

Version Date Modifications 

V1.0 01/2014 First version 

V1.1 03/2019 Second Version adopt to BRAUMAT / SISTAR V7.5 

V2.0 07/2019 Various changes 
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